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◆ Introduction 

The master’s or doctoral thesis is required for the conferral of a graduate degree at Yonsei 

University. The manuscript is expected to be an original contribution to the student’s field of 

research and the result of sustained scholarship and research. The thesis will be held in the 

Yonsei University Library and made available to the public (on the Web as well as in printed 

forms. This booklet provides directions about the format of the thesis in order to help students 

write their master’s or doctoral Thesis in English at Yonsei University.  

Students can choose, in consultation with their thesis advisor, to write their Thesis in English. 

Once this decision has been made, students should follow the guidelines in this booklet, which 

provides the standard format requirements for Thesis in all departments. For field-specific 

differences in bibliography, citations, etc., style manuals given in the “References” section 

below. Note that this booklet supplements the Academic Regulations of Graduate 

School(대학원 학칙 및 내규), and that the overall requirements of Graduate School for all 

Thesis and graduation requirements must be met. Further detailed information on researching, 

writing, and formatting of the thesis is available in the Guidelines for Writing Thesis at 

Graduate School(새논문작성법). 

 

 

◆ Requirements 

 

1. Writing Thesis in English 

The language of the master’s or doctoral thesis at Yonsei University is generally Korean, but 

Thesis written in English are also encouraged. Students must consult with their thesis advisor 

and obtain an advance approval for the thesis written in a language other than Korean, including 

English. Thesis written in languages other than Korean or English are also permissible upon 

approval by the thesis advisor if the foreign language is appropriate for the subject of the thesis.  

 

 

2. Eligibility for Submission of Thesis 

Students must meet certain conditions before they are eligible to submit Thesis. All students 

must have passed their qualifying examinations and have been under the guidance of a thesis 

advisor for at least one semester for a master’s student, or for at least two semesters for a 

doctoral or combined master’s/doctoral student. All students must finish their degree programs 
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within a specified period – four years for a master’s student, seven years for a doctoral student, 

and eight years for a combined master’s/doctoral student. However, in cases when a student 

has been on leave or has other permissible reasons, the Dean of the Graduate School can grant 

the student up to two more years to complete the degree program.  

 

 

3. Scope and Breadth of Thesis 

The thesis must be an original contribution to the student’s field of scholarship. The master’s 

thesis must demonstrate a strong fundamental understanding of the student’ s filed of research, 

focus on a subject of scholarly relevance, and be clearly written and well organized.  

A doctoral dissertation must demonstrate a capacity for original research, present a clear 

argument that demonstrates how the student’s research revises or expands existing boundaries 

of knowledge or technology. Both the master’s and doctoral Thesis should reflect not only 

mastery or research techniques but also an ability to select and important problem for 

investigation and to execute it competently. As long as the length of the thesis is concerned 

there are no restrictions. Master’s Thesis are usually under 150 pages with 1.5-or double-

spacing, and doctoral dissertations are usually under 300 pages with 1.5-or double-spacing.  

 

 

4. Thesis Adivsor 

All students must select and be approved by a thesis advisor (principal advisor) in their field 

of study before embarking on a thesis. The thesis advisor must be a full-time faculty member 

at Yonsei University; professors, associate professors, and assistant professors with final degree 

in their field (usually a Ph.D.) are eligible. In order to ensure that the thesis advisor will be able 

to finish supervising the thesis, the thesis advisor must be a faculty member who has at least 

four semesters remaining for a master’s student or six semesters remaining for a doctoral 

student before retirement.  
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◆ Submission of Thesis 

1. Copies of Preliminary Manuscript 

In order to facilitate preliminary review of the thesis, master’s students must submit three (3) 

copies, and doctoral students five (5) copies of their manuscript to their thesis committee. The 

final thesis must be submitted to the Yonsei University Library after obtaining an approval from 

the thesis advisor and committee members.  

 

 

2. Thesis Committee 

The thesis committee which reviews and approves master’s and doctoral Thesis is appointed 

by the Committee of the Graduate School. Upon the request from the department chair, the 

Committee of the Graduate School appoints thesis committee members to review the thesis. 

Committee is composed of three faculty members for a master’s thesis and five for a doctoral 

dissertation, and up to one (master’s) or two (doctoral) of Thesis committee members can be 

from outside of the University. The thesis advisor automatically becomes a committee 

member; the Committee of the Graduate School follows the recommendation of the 

department chair in appointing a Chair of the thesis committee. Any faculty member is eligible 

to be thesis advisor (see “The Thesis Advisor” above) as well as to serve on the thesis 

committee. 

 

3. Preliminary Review of Thesis 

The master’s and doctoral thesis must be carefully reviewed by all the members of the thesis 

committee, and approved by that committee before final submission. 

 

A. Master’s Thesis must be carefully reviewed by members of the thesis committee. The 

degree candidate must give a public presentation of the thesis to the members of the thesis 

committee and his/her department, and must answer questions posed by thesis committee 

members and other audiences at the presentation. The thesis committee chair then submits 

the results of the evaluation of the candidate’s performance to the Dean of the Graduate 

School after consultation with other committee members.  

 

B. Doctoral dissertations must be carefully reviewed by members of the thesis committee. 

The degree candidate must give a public presentation of the dissertation to the members 
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of the thesis committee and his/her department, and must answer questions posed by thesis 

committee members and other audiences at the presentation. The candidate must pass an 

official preliminary examination for the dissertation within the designated period 

determined by the Dean of the Graduate School. The thesis committee chair then submits 

the evaluation of the candidate’s performance to the Dean of the Graduate School after 

consultation with other committee members.  

 

 

4. Final Manuscript and Review 

The final manuscript of the master’s and doctoral thesis must be faithfully 

revised/supplemented, under the direction of the thesis advisor, according to the 

recommendations and suggestions made by the thesis committee. The final manuscript must 

follow the format specified below in “Format of Thesis”, and must be submitted to the 

Library by the specified deadline. The manuscript will then be subject to final review and 

approval by the thesis committee. If needed, the thesis committee can request the candidate to 

submit materials, sources, and other references used in the thesis. The thesis committee must 

make the final approval that the thesis is a significant contribution to knowledge and an 

acceptable piece of scholarly writing. In the process of evaluating the manuscript, the 

master’s thesis must get at least 80 points (out of a maximum of 100) from at least two out of 

three thesis committee members, and the doctoral dissertation must get at least 80 points (out 

of a maximum of 100) from at least four out of five thesis committee members. If a candidate 

fails, a revised and improved thesis can be resubmitted one semester later.  

 

 

◆ Format of Thesis 

The format of the final submitted manuscript must conform to the following requirements. 

Because this final volume will be stored in the University Library and made available to the 

public, the Graduate School will not accept any thesis not conforming to the following 

requirements.  

 

1. Physical Requirements 

A. Paper. Use white, standard A4 size paper (210 x 297 mm).  

 



페 이 지  - 7 - | 36 

 

B. Typeface and printing. The manuscript must be typed or machine-printed using one 

of the following fonts: Times New Roman font. The entire manuscript must maintain a 

neat appearance and be free of mistakes. For font size guidelines, use an 16-point size in 

bold for main chapter headings, 13-point size font in bold for subheadings, and 10- or 11-

point size for the main text. Footnotes should be in 9-point size. Maintain either 1.5- or 

double-spacing throughout the manuscript.(However, 1.15 spacing for MS Word) 

 

C. Margins(for MS Word). Use a minimum of 3.5cm margins on the right and left side. 

Use 5.3cm margins for the top and bottom. For header, use 1.5cm and for footer, use 

3.2cm margins.  

 

D. Alignment and Indentation. Indent the beginning of paragraphs by 2 spaces and 

utilize  justified alignment. 

 

E. Page Numbers. Number each page throughout the manuscript with page numbers 

centered at the bottom relative to the text (not relative to the paper). Every sheet of paper 

in the manuscript must be numbered except for the title page (counted but not numbered). 

Use lower case Roman numerals (i, ii, iii, and so on) for the “preliminary pages” (see 

below in “Order of the Manuscript”; from the title page through to the last page of abstract). 

Since the title page is counted but not numbered, the initial page number “i”, and it is 

placed on the table of contents. The page following the last page of the abstract is the first 

page of the “text” (see below in “Order of the Manuscript”) and is numbered “1” and these 

Arabian numerals (1, 2, 3, and so on) continue to the last page of the manuscript, including 

any blank pages. 

 

2. Arrangement and Contents 

The contents of the thesis and the internal arrangement of the text and reference sections are 

determined by the student in consultation with the thesis advisor. Manuals for the style which 

governs the format of citations, bibliography, tables, etc., for different fields are provided in 

the “References” section below.  

The order of the preliminary pages must be exactly same as follows. No exceptions are allowed. 

Sample pages follow in the “Appendices” section below. Sample pages allow differences in 

master’s and doctoral Thesis. For cases not addressed in the samples below, consult your thesis 

advisor and the Guidelines for Writing Thesis at Graduate School.  
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Order of Manuscript 

 

A. Preliminary Pages 

1) Title page (counted but not numbered; see Appendix 2) 

2) Signature page (see Appendix 3) 

3) Dedication or acknowledgements (usually optional; any copyright permissions 

obtained must be listed in an “acknowledgements” section) 

4) Table of contents  

5) List of Figures, Tables (if applicable) 

6) Abstract in English (two pages or less) 

 

B. Text 

1) Text: divided into Preface (if any), Introduction (if any), body of text (usually 

divided into chapters or sections)  

2) Appendices (if any) 

3) References/Bibliography/List of Works Cited 

4) Abstract in Korean (two pages or less) 

 

◆ References 

Consult the following references for more in-depth guidelines on form and bibliography. 

Consult your thesis advisor for advice on which style is the most appropriate for your field or 

department. 

 

Guidelines for Writing(새논문작성법).서울: Yonsei University 

The Chicago Manual of Style. 14th Ed. Chicago: U of Chicago P, 1993.  

Day, Robert A., Ed. How to Write & Publish a Scientific Paper. 5th Ed. Oryx P, 1998.  

Day, Robert A. Scientific English: A Guide for Scientists and Other Professionals. 2nd Ed. 

Oryx P, 1995. 

 

Gibaldi, Joseph. MLA Style Manual and Guide to Scholarly Publishing. 2nd Ed. New York: 

Modern Language Association of America, 1998.  
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Rudestam, Kjell E. and Rae R. Newton. Surviving Your Dissertation: A Comprehensive Guide 

to Content and Process. 2nd Ed. Sage Publications, 2001. 

Strunk, William. The Elements of Style. 4th Ed. Boston: Allyn and Bacon, 1999. 

Zerubavel, Eviatar. The Clockwork Muse: A Practical Guide to Writing Thesis, Dissertations, 

and Books. Cambridge: Harvard UP, 1999.  

 

[References example] 

Tversky, A., & Kahneman, D. (1971). Belief in the law of small numbers. Psychological 

Bulletin, 76(2), 105–110. (APA style) 
 

Doggart, Julia. "Minding the Gap: Realizing Our Ideal Community Writing Assistance 
Program." The Community Literacy Journal, vol. 2, no. 1, 2007, pp. 71-80. (MLA style) 
 

G. Liu, K. Y. Lee, and H. F. Jordan, "TDM and TWDM de Bruijn networks and shufflenets 
for optical communications," IEEE Trans. Comp., vol. 46, no. 9, pp. 695-701, June 1997. 
(IEEE style) 
 

Publication Manual of the American Psychological Association: The Official Guide to APA 

Style. (2019). United States: American Psychological Association. 
 

◆ Appendices 

Below, you will find sample pages for the cover page (outer cover), title page, and signature 

page, etc., along with information regarding pagination and plagiarism checks. Consult these 

sample pages as well as the section on “Format of Thesis” above.  

 Appendix 1. Sample Cover page 

Appendix 2. Sample Title page 

Appendix 3. Sample Signature page 

 Appendix 4. Pagination Setting Information for MS Word 

 Appendix 5. Pagination Setting Information for 한글 
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Yonsei University Graduate School  

Thesis Formatting Guidelines 
  

 

 

1 
 Order of Forms 

1) Cover page 

2) Title page 

3) Signature page 

4) Table of contents 

5) Abstract in English 

6) Reference 

7) Abstract in Korean 
 

 

2 
 Guidelines for completing the form 

1) The red text is a reference which needs removal when printing. 

2) The blue text should be modified to black when printing. 

3) The black text is fixed and should not be modified. 

4) Do not modify the margins or table size of this form. All modifications 

should be made according to the instructions. 

5) Memo is reference so please remove it when printing. 

 
 

3 
 Order of Manuscript 

1) Title page (counted but not numbered; see Appendix 2) 

2) Signature page (see Appendix 3) 

3) Dedication or acknowledgements (usually optional; any copyright 

permissions obtained must be listed in an “acknowledgements” section) 

4) Table of contents  

5) List of Figures, Tables (if applicable) 

6) Abstract in English (two pages or less) 

7) Text: divided into Preface (if any), Introduction (if any), body of text 

(usually divided into chapters or sections)  

8) Appendices (if any) 

9) References/Bibliography/List of Works Cited 

10)  Abstract in Korean (two pages or less) 
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total top margin should be 6.8cm. (Prohibit changing the table height.) 

Women and the War Effort: 

O O O O O O [Thesis Title] (18p) 

 

 

Hong, Gildong [Author Name] (18p) 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

Department of [○○○] (18p) 

Graduate School 

Yonsei University 

 

Appendix 1 : 

Sample Cover page 

(delete) 
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total top margin should be 6.1cm. (Prohibit changing the table height.) 

Women and the War Effort:  

O O O O O O [Thesis Title] (16p) 

*  ** 

Advisor ○○○·○○○ 
 
 

 

A [Dissertation/Master’s Thesis] 

Submitted to the Department of [○○○] 

and the  Committee on  Graduate School  

of Yonsei University in Partial Fulfillment of the 

Requirements for the Degree of 

[Doctor of ○○○/Master of ○○○](16p) 

 

Hong, Gildong [Author Name](16p) 

 

December 2025 [Month/Year of Submission](16p) 

Appendix 2 : 

Sample Title page 

(delete) 
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Appendix 3 :  

Sample Signature page 

(delete) 

Women and the War Effort: O O O O O O 

[Thesis Title] (13p) 

This Certifies that the [Dissertation /Master's Thesis] 

of [Sung, Chunhyang] is Approved(13p) 

 

Ad

vis

or 

 

Co

m

mitt

ee 

Me

mb

er  

Typ

ed 

na

me 

: 

The

sis 

Co

m

mitt

ee 

Me

mb

er  

 [signature] 

 

 

 Committee  Chair Hong, Gil-Dong 

 

 

  [signature] 

 

 

 Committee Member 

Typed name: Thesis 

Committee Member 

Lee, Na Ra 

 

 

  [signature] 

 

 

 Committee Member 

Typed name: Thesis 

Committee Member 

Kim, Na Ra 

 

 

  [signature] 

 

 

 Committee Member 

Typed name: Thesis 

Committee Member 

Kim, Dae Han 

 

 

  [signature] 

 

 

 Committee Member 

Typed name: Thesis 

Committee Member 

Lee, Dae Han  

Three signatures total in case of master’s 

Department of ○○○ [Department name] 

Graduate School 

Yonsei University (13p) 

(December/June) 2025 [Month/Year](13p) 
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Abstract in Korean (13p) 

 

계층적 표현에 의한 의료영상의 3 차원 구성 및 처리(13p) 
 

본 논문은(10p, 들여쓰기 2 칸) 

(박스 삭제 요망) 

● 국문 요약이란? 

국문 요약은 논문의 전체적 흐름과 논지를 간단히 밝혀 적는 것으로, 읽는 이들에게 

부분적인 사소한 문구나 표현에 빠지지 않고 논문 전반의 방향을 이해하도록 도와주는 

구실을 한다. 따라서 국문 요약은 결론 부분의 단순한 사전 누설이 아니라, 전반적인 

흐름에서 벗어나지 않도록 읽는 사람에게 길잡이의 구실을 해야 한다. 마치 사소한 

바람이나 파도 때문에 잘못된 뱃길에 접어들지 않게 하는 나침반의 노릇을 한다고 

생각하면 좋다. 

출처: <새 논문 작성법> 36-37 쪽 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

__________________________________________________________________ 
핵심 되는 말 : 계층적 표현(10 단어 이내)(10p) 



Appendix 4: Pagination Setting Information for MS Word 

 

Pagination How-to (using MS Word) 
 

1. Basic page settings 

 

1) First, click Format → Document → Document Grid from the menu. Then click OK. 

(Note that this process is to write basic page numbers for the whole document.) 

 
 

 

 

2) Click Insert → Header & Footer → Page Number and apply the following instructions: 

 Position: Bottom of Page (Footer) 

 Alignment: Center 
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3) Click on Format from the Page Numbers window. Select the page number format of your 

choice in the Page Number Format window. 

 

        
 

 

2. If you wish to have more than one page layout or page number setting in one 

document 

 

1) To set a different page numbering system for certain pages, try a section break. By clicking 

Layout → Breaks → Section Breaks → Next Page, you will be able to start a new section 

on the next blank page.  
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2) Click Format → Document and select ‘This section’ from the Apply to option. Press OK. 

(This allows the page section to function independently, enabling it to have its own separate 

page property.) 

 

 
 

Apply the page number format and page numbering of your choice from the Header & Footer 

menu.  
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3) In the first header of each new section, double click on the footer and uncheck ‘Link to 

Previous’. Doing this ensure  that even if you delete the page number field of the previous 

section, it will not affect the current section. 

 

 
 

4) If you always want to start with a new page and a new format, you can repeat the steps 

described in step number 2. 
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Appendix 5: Pagination Setting Information for 한글 

Pagination How-to (using 한글 ver.2020) 

 
1. Page settings 

 

a. Select [쪽] from the menu and click [쪽 번호 매기기].  

b. Once your screen looks like Figure 1-1, you can choose the location of your page 

number, decide whether it should be a number or a Roman numeral, and determine 

whether it should have a dash before and after the number. 

 

 
<Figure 1-1> 

 

c. For example, if you want to set your page number in the center as an Arabic numeral 

with a dash around it, refer to Figure 1-1. 
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2. If you wish to have more than one page layout or page number setting in one 

document 

(For example, use Arabic numerals for pages 1, 2, 3, 4, and switch to Roman numerals for 

subsequent pages).  

 

a. First, place the cursor one page before the desired page where you want to change 

the page number. Make sure the cursor is positioned at the very bottom of the page 

before the desired page. 

b. Select [쪽] from the menu and click [구역설정]. 

c. You’ll find your screen similar to Figure 1-2. -> 

Your screen should look like figure 1-2 

 
<Figure 1-2> 

 

d. Refer to Figure 1-2 and apply the settings inside the red box.  

- 시작 쪽 번호 – 종류 : 사용자 

- 시작 쪽 번호 – 값 : 4 (This number stands for the number that you wish to start 

on your page.-> (This number represent the starting page number you want for 

your document. 
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- stands for the number that you wish to start on your page.-> 

-  

-  For example, if you wish to start your page number as ‘4’ on the third page of 

your document, you may select the number ‘4’ in this option.) 

- 적용 범위 : 현재 구역 

- If you apply this setting, you may notice the appearance of a blank page. In such a 

case, you can remove the blank page by pressing the backspace key from that 

page. 

- If you apply this setting, you may notice of a blank page. In that case, you can 

remove the blank page by pressing the backspace key on that page. 

-  

 

 

e. Click [쪽] – [쪽 번호 매기기]. 

 
<Figure 1-3> 

f. Select the page number type of your choice as shown inside the red box. 
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Research Ethics FAQ(Graduate School) 

 

2023.12. Research Ethics Center at Office of Research Affairs 

 

 

1. What is research misconduct?  

▶ According to the university’s [Research Ethics Regulations], research misconduct can be defined as follows.  

Article 9 (Scope and Verification of Research Misconduct) 

 

① 'Research misconduct' refers to fabrication, falsification, plagiarism, invalid authorship, unjust 

duplication publication, interruption of research misconduct investigation, etc., carried out in the 

proposal, execution, reporting, and presentation of research, as defined in the following subparagraphs. 

It also includes instances where individuals propose, coerce, or pressure others to engage in the 

aforementioned acts of misconduct. However, this excludes cases caused by minor negligence or 

differences in the interpretation or judgment of data and research results. 

 

1. ‘Fabrication’ refers to the act of producing, recording, or reporting primary research materials, 

research materials, or research results that do not exist. 

2. ‘Falsification’ refers to the act of distorting research content or results by artificially manipulating 

research materials, equipment, processes, etc., or arbitrarily modifying or deleting primary 

research materials or research materials.  

3. ‘Plagiarism’ refers to the act in which a third party utilizes other people's original ideas, which are 

not generally available knowledge, or creations without properly crediting the source and passes 

them off as their own work. However, the determination of plagiarism is primarily based on the 

opinions of experts in the relevant academic field, such as scholarly societies.  

a. Using all or part of someone else's research content without proper citation. 

b. Modifying some of the words or sentence structures from another person's work while not 

providing proper attribution. 

c. Incorporating someone else's original thoughts or ideas without appropriate citation. 

d. Using another person's work through translation without citing the source. 

e. Presenting all or part of the core concepts from research content published or presented by 

someone else as if they were one's own research concepts, without proper citation. This includes 

cases where research primary data or materials such as graphs, charts, diagrams, or images are 

different. 

f. Cases in which the cited material becomes the main content of a new work, even if the source 

of the original work is acknowledged 

g. Unfairly using unpublished creative works or ideas of others without proper citation. 

4. ‘Invalid authorship’ refers to the act of not conferring author status, without justifiable reasons, to 

someone who has made an academic contribution to the research content or results, or conferring 
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author status to someone who has not contributed academically on grounds of appreciation, 

courtesy, etc. In these cases, while it generally constitutes improper authorship attribution if it 

violates the following points, specific judgments may align with the practices and norms within 

the respective academic field.  

a. Those who significantly contribute to planning the research, data collection, analysis, critical 

revisions of key content, or substantially contribute to the composition of the research content 

or results can be considered as authors. 

b. Individuals responsible solely for securing research funds, data collection, or research 

management cannot be considered authors, but their assistance in direct or indirect support of 

the research can be acknowledged in acknowledgments. 

c. The order of authorship attribution should be determined based on the authors’ relative 

contributions to the research, with consensus among the participating authors. 

d. The author's affiliation should be indicated based on their affiliation at the time of conducting 

the research, such as during experimentation and data analysis. 

e. The corresponding author is responsible for the entire process of writing, submission, 

revisions, and publication of the paper, and they should inform and receive approval from co-

authors. 

f. A supervising professor should not publish or present a graduate student's thesis in academic 

journals or elsewhere solely under the professor's name. 

5. ‘Unjust duplication publication’ refers to the act in which a researcher obtains unfair benefits, such 

as research funds or recognition for separate research achievement, after publishing a work that is 

identical or substantially similar to previous research without citing the source. When determining 

whether improper duplicate publication has occurred, the following factors should be considered: 

a. The assessment of duplicate publication typically focuses on papers published in academic 

journals. However, whether to include theses, research reports, conference papers, and similar 

works in this assessment depends on the standards and practices within the specific academic 

field. 

b. Compiling research results from previously published papers into a book does not constitute 

duplicate publication. However, appropriate citation should be provided in such cases. 

c. Publishing content from an academic journal in a popular book or general interest magazine 

does not constitute duplicate publication. 

d. Republishing a longer paper (full paper) that includes additional research results, 

interpretations, or detailed research procedures after publishing a shorter form paper (letter, 

communication) does not qualify as duplicate publication. However, proper citation is essential 

in this scenario as well. 

e. When the same research results are published in a different language, proper citation of the 

original paper and obtaining prior approval from the respective journal does not constitute 

duplicate publication. 

6. ‘Interruption of research misconduct investigation’ refers to the act of intentionally interfering in an 

investigation of misconduct or inflicting harm on the complainants.  

7. It includes behavior beyond commonly tolerable scope of each research field  

 

2. What should we know to prevent research misconduct? 

▶To prevent research misconduct, researchers must ensure throughout the entire research process that (1) 
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Deliberate research misconduct such as fabrication, falsification, plagiarism, etc., is strictly prohibited, and (2) 

Unintentional errors stemming from the researcher's incompetence, negligence, or self-deception do not interfere. 

Hence, researchers should ensure they conduct their research diligently, honestly, and pay sufficient attention to 

detail to uphold accuracy.  

(1) Guidelines for Preventing Fabrication and Falsication  

(1) Researchers must present research findings honestly without forgery/fabrication, falsification, or inappropriate 

data manipulation. Altering research images (e.g., microscope images, radiographs, gel electrophoresis images) in 

a misleading manner is strictly prohibited. 

(2) Researchers should strive to describe methods clearly and distinctly and report results following guidelines. 

Publications should provide sufficient detail for other researchers to replicate experiments successfully. 

(3) Research reports must be complete. Omitting findings or results that do not support the author's or 

sponsor's hypotheses or interpretations due to discomfort, inconsistency, or an inability to explain is 

unacceptable. 

(4) Funders and sponsors of research should not have the authority to reject the publication of 

unfavorable outcomes related to their products or status. Researchers should not draft agreements 

allowing sponsors to refuse or control the release of results (excluding exceptional cases such as 

research classified as confidential by the government due to security concerns). 

(5) Authors should promptly notify the editor if they discover errors in a submitted, accepted, or 

published paper. If necessary, authors should collaborate with the editor to issue a correction article or 

retract the paper. 

 

<Source: First Steps in Research Ethics for New Researchers. Korea Research Foundation. 2019> 

(2) Proper Citation as Method for preventing Plagarism  

Here are several methods for proper citation for accurate referencing. 
1. When using a portion of someone else's work verbatim (copying), paraphrasing, summarizing, or utilizing 

someone else's ideas, credit must be given for the contributions made by others. 
2. When using specific sections of someone else's work verbatim, those sections must be marked with quotation 

marks (" "). 
3. When paraphrasing sections of someone else's work, ensure a complete understanding of the content and 

rephrase it in your own words while acknowledging the source. 
4 Any opinions, criticisms, historical facts not originally considered by the researcher should be properly cited 

whether quoted directly or paraphrased. 
5. When uncertain about whether a fact or idea constitutes common knowledge, it's essential to cite the source. 
6. Information or data obtained from online sources must be cited just like material or information from one's or 

others' papers or publications. 
7. Factual information acquired through research, such as statistical data, requires proper citation. For instance, 

when answering a question like "How many people die from heart disease in Korea each year?" relying on someone 

else's research findings, it's essential to cite the source for that information. 

 

<Source: Understanding and Practicing Research Ethics. Korea Research Foundation. 2011>  
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 (3) Prevention of Self-plagiarism and Improper duplicate publication 

 

(4) Efforts to Prevent Improper Authorship Attribution 

An author refers to someone who has made a substantial intellectual contribution to the research, takes 

responsibility for the integrity of the research, and has reached an agreement among the research team 

regarding being listed as an author (consent among researchers regarding authorship is crucial) 

 

Authors can be classified into three types:  

the first author (primary author), co-author, and corresponding author. 

 

① First Author (Primary Author): Refers to an individual who has played a significant role in 

generating data by collecting it, conducting experiments, interpreting the results, and drafting the 

manuscript. However, in cases of collaborative research, there can be multiple first authors. 

② Co-Author: Refers to an individual who has significantly contributed to the research project 

▶ Self-Plagiarism and Improper duplicate publication 

※ Caution regarding the utilization of a researcher's previous work in subsequent publications: 

- Even if a researcher modifies some content or adds new material from their previous work, if there is 

no qualitative difference in the argumentation and conclusions between the two works, they are 

essentially similar publications. 

- There exist various types of ethical issues in academic writing, including self-plagiarism, duplicate or 

redundant publication, salami/segmented publication, and imalas publication. 

- Despite being one's own work, copyright often belongs to the journal or publisher. Hence, when 

utilizing parts or the entirety of one's previous research, proper citation is necessary, and permission 

from the original journal's editor for the initial publication should be obtained. 

 

▶ Typical Types of Improper duplicate publication 

- Salami Publication: 

Dividing a single research paper into two or more smaller papers for publication, for instance, extracting 

portions from a thesis to publish multiple smaller papers. (However, this may vary across academic 

disciplines.) 

- Imalas Publication:  

Presenting, as if it were an entirely new paper, by adding some research outcomes or clinical cases to 

an already published paper. (However, it is acceptable if there is substantial new academic value even 

when reusing some of the previous research outcomes.) 

 

<Source: First Steps in Research Ethics for Junior Researchers. Korea Research Foundation. 2019> 
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alongside the first author, participating in data collection, analysis, interpretation, conclusion drawing, 

and report writing. 

③ Corresponding Author: As an author submitting a manuscript to a scholarly journal for publication, 

it's essential that the corresponding authors is able to communicate easily with the publisher or readers 

before, during, and after the publication process. 

The following improper authorship attributions clearly constitute violations of research ethics, so caution should 

be exercised during thesis writing. 

① Granting authorship despite no intellectual contribution or involvement in the research 

content or outcomes 

- Coercion Authorship: When a senior researcher within a research lab or department uses their 

position to pressure junior researchers to include their name in a paper. 

- Honorary Authorship: Including the name of a well-known figure who did not contribute to the 

research (done either to gain favor with the individual or to enhance the credibility of the paper). 

- Mutual Support Authorship: Adding the name of a well-known individual who hasn't 

contributed to the research (done either to flatter the individual or enhance the credibility of the 

paper). 

② Failure to attribute authorship despite intellectual contributions or contributions to the 

research content or outcomes. 

- Ghost authorship: When someone who significantly contributed to the research is excluded 

from the paper's authorship (also considered plagiarism as they might have used another person's 

research results without proper citation). 

 

<Source: First Steps in Research Ethics for New Researchers. Korea Research Foundation. 2019> 

3. Frequently Asked Questions (FAQ) 

(1) When the source is cited in the main text, is it necessary to cite the source again when it is mentioned in 

the Korean abstract, introduction, conclusion, etc.? 

Abstracts summarize the nature of a research paper in the author's own words and generally do not 

require source citations for references. This is because when summarizing significant ideas or 

expressions from others cited in the main text, their sources can be traced back to the main body of the 

paper. However, when restating content quoted from the main text in the introduction or conclusion, it 

is necessary to provide the sources. 

<Source: Integrated Guide to Research Ethics for Practitioners. 2021> 

 

(2) How should the results of a 'plagiarism detection program' be utilized? If the plagiarism check result 

percentage meets the criteria set by the academic society of 'plagiarism probability 10% or less', is it 

safe to submit the manuscript?  
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The sentence similarity percentage (%) from plagiarism detection software alone cannot determine 

whether it's plagiarism. The numeric result simply indicates the similarity between sentences in Work 

A and Work B, implying similarity but not directly equating to plagiarism. However, it's reasonable to 

speculate that higher sentence similarity percentages suggest a greater likelihood of plagiarism. 

 

Depending on the nature of the academic field or the research topic—for instance, in disciplines 

requiring extensive citation of classical texts or in papers focusing on reviewing existing research—the 

sentence similarity score may naturally be high. However, it's crucial not to hastily conclude plagiarism 

in such cases. Instead, a meticulous examination should determine whether the similar content 

represents someone else's original and crucial ideas or unique research content rather than common 

knowledge. Conversely, even a single similar sentence might constitute plagiarism if it includes 

essential content or original ideas from another work. Therefore, it's advisable for experts in the 

respective academic fields to accurately determine cases of plagiarism. 

 

Sentence similarity checks serve as auxiliary tools to quickly identify the likelihood of potential 

plagiarism and for preventive measures. However, they cannot precisely detect cases such as plagiarism 

in a single sentence. Relying solely on the numerical results of these checks for assurance is not 

advisable. Therefore, even if the sentence similarity check meets the criteria set by the academic 

community, it's essential to thoroughly review the parts highlighted as 'suspected plagiarism' in the 

assessment results. Strengthening citations and references by cross-referencing the original text is 

advisable. To truly avoid plagiarism, it's crucial to express one's thoughts in one's own words above all 

else. 

 

<Source: Integrated Guidebook on Research Ethics for Practitioners, 2021> 

 

(3) I am currently in a doctoral program in the field of science and engineering, and I intend to publish 

some of my research work in a journal before including it in my doctoral thesis. Would publishing 

research content in a journal first and then using that content in my thesis be considered self-

plagiarism or duplicate publication? Conversely, would presenting a paper in a journal based on the 

research results of my thesis after obtaining the degree be considered duplicate publication? 

An article published in a recognized academic journal has undergone peer review and is officially 

published. Therefore, utilizing significant data or research content from this publication in a doctoral 

thesis is not considered duplicate publication as long as proper attribution is provided. How previously 

published papers are cited in a doctoral thesis should comply with the regulations outlined in the 

university's guidelines for thesis submission. 

In the opposite scenario, whether the content in a doctoral thesis can be published in an academic journal 

depends on whether the academic field considers a doctoral thesis an official publication or the 

publishing policy regarding submissions based on theses in that particular journal. Therefore, it is 

crucial to review any regulations or established practices governing this matter and proceed 
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accordingly. 

In engineering and natural sciences, utilizing research outcomes from a doctoral thesis for publication 

in domestic or international academic journals is generally viewed as acceptable without constituting 

duplicate publication. However, in humanities and social sciences, there are academic journals where 

using thesis content for journal articles is prohibited. Even in cases where it's allowed, these journals 

may require acknowledgment that the article is based on a doctoral thesis. Therefore, authors need to 

verify the publication ethics standards of the relevant journals when publishing articles based on their 

theses. 

In engineering and other technical fields, there are opinions that you don't need to cite your thesis in a 

research paper since it's considered an unpublished work, like an unpublished doctoral dissertation or 

master's thesis. However, considering today's internet access where theses are converted into PDFs and 

readily available, it's advisable to provide the source whenever possible, when using information from 

a thesis in scholarly articles. 

 

<Source: Integrated Research Ethics Guidebook for Practitioner,. 2021> 

 

(4) Can parts of a jointly published research paper be reused in a thesis? 

Reusing certain research content included in a thesis that was previously presented in a scholarly journal 

is a common practice in the field of science and engineering, not only in Korea but also in many other 

countries. However, when crafting the thesis based on content already published in a journal, it's crucial 

to acknowledge that the same content was published in the journal by providing citations.  

There's a critical aspect that requires particular attention in this context. For instance, if a student, as 

one of the authors in a jointly published academic paper involving multiple researchers, directly 

incorporates the entire content of that paper into their thesis, it could raise issues of plagiarism and 

copyright infringement. Including any part of data or text produced by others in their thesis without 

explicit consent is a violation of copyright. Even with prior consent, using someone else's content 

without proper acknowledgment constitutes plagiarism and research misconduct. If there's a necessity 

to refer to others' data, it must be cited within the text. Discussing and obtaining consent from the 

advisor or advisor beforehand when constructing a thesis based on previously published research 

outcomes is crucial in preventing such issues. 

<Issues and Answers in Research Ethics, 2016> 

 

(5) Is it possible to present the results obtained from project participation in both a thesis and a scholarly 

journal article? 
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In engineering and related fields, research often involves professors securing research funds and 

conducting studies jointly with graduate students. The graduate students, under the guidance of their 

professors, conduct research and subsequently write their theses based on this research. Consequently, 

after completing a research project, a final research report and the student's thesis may emerge, where 

research methods or data might overlap. 

If the student's thesis is submitted first, it's possible to use the research methods, data, interpretation, 

conclusions, etc., from this thesis to compose a research report. In the realm of engineering research, 

utilizing a graduate student's thesis as the basis for a research report submission isn't generally 

considered an ethical concern due to the nature of research practices. However, when presenting the 

research outcomes from such projects in the form of a thesis or academic paper, it's important to 

appropriately comply with guidelines specified in research project agreements, considering the 

guidelines or conditions outlined by the supporting institution regarding the presentation and use of 

research outcomes. Sometimes, approval from the supporting institution may be necessary or citations 

might be required when utilizing research results. 

In general, research funding is expected to support new findings on topics that have not yet been 

explored. It's acceptable to utilize the results from a new research topic funded by a grant for both a 

thesis and as a report for the funding source. However, if the thesis has already presented certain 

research findings, and later, similar findings from a related grant-funded project are to be published in 

an academic journal, this might raise ethical concerns. It could be considered as not planning for a new 

topic from the point of applying for the research grant, as the content was already disclosed. This could 

be seen as deceiving the research funding institution, which anticipates results from a new research 

topic, as well as the readers who trust in the credibility of the research. 

<Source: Q&A on Research Ethics, 2016> 

 

(6) What is the scope of review for the Institutional Review Board (IRB)?  

The application of the <Bioethics and Safety Act> applies to research that (1) qualifies as research and 

(2) involves subjects of human (or human-derived materials). 

Simple surveys (exit polls, opinion surveys), investigations related to business activities (market 

research, product satisfaction surveys), and other surveys based on generalized knowledge not 

systematized as research do not fall under research and are therefore not subject to IRB review. 

In the case of project research, it is generally mandatory to undergo IRB review during the research 

process.  

However, for dissertations at the master's or doctoral level, the decision to undergo review is at the 

researcher's discretion. Nevertheless, in the case of research involving human subjects, researchers 

should be cautious as it could pose an issue if they submit and publish academic papers in domestic and 

international journals based on their thesis after its completion. 
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<Source: Guidance on Managing Institutions Related to Bioethics Laws, 2013> 

 

(7) Can research data collected through surveys be separated and published as individual papers? 

The primary consideration should be why one would seek to divide the data collected for four variables 

through a single survey into separate publications rather than presenting it in an integrated form. It's 

important to reflect on whether the original intention wasn't to collect data for multiple variables under 

the guise of the inconvenience or difficulty of data collection and then publish individual papers by 

analyzing each variable. This is crucial because if presenting the data separately (often referred to as 

'salami slicing') results in a lack of comprehensiveness and coherence compared to presenting it 

together, it becomes challenging to justify the data separation. 

If sufficient justification is possible within the first consideration, given that each paper utilizes different 

variables, it can be deemed acceptable to publish them separately. However, since the subjects, 

methods, and duration of the surveys are likely the same, and this data has already been utilized in the 

doctoral dissertation and will be used similarly in subsequent academic papers, it's crucial to clearly 

indicate the sources for previously used data or related content. Furthermore, describing the 

connections, differences, and the significance of other variables from the same sample across the 

doctoral dissertation and later journal articles can aid readers in understanding the differences between 

the two papers despite their overlapping aspects. 

<Source: Research Ethics Q&A, 2016> 

 

 


